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Die OSGi Service Platform ςDas Buch



» OSGi-Technologieim Überblick
» Tutorial: Eclipse IDE / Beispieleinstallieren

» Bundles
» Tutorial: EinHistogram-Bundle

» Package-AbhängigkeitenzwischenBundles
» Tutorial: Definition von Package-Abhängigkeiten

» Bundle-Lebenszyklus
» Tutorial: Bundle zurLaufzeitinstallieren

» OSGi Services
» Tutorial: Services anmeldenund abfragen

» Umgangmit dynamischenServices
» Tutorial: Arbeitenmit demServiceTracker

Agenda
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» 5ƛŜ h{Dƛ {ŜǊǾƛŎŜ tƭŀǘŦƻǊƳΧ

» Χ ƛǎǘ Ŝƛƴ dynamisches Modulsystem für Java.

» Χ ŜǊƳǀƎƭƛŎƘǘ ŘƛŜ ŘȅƴŀƳƛǎŎƘŜ LƴǘŜƎǊŀǘƛƻƴ ǳƴŘ Řŀǎ aŀƴŀƎŜƳŜƴǘ 
von Softwarekomponenten (Bundles) und Diensten (Services).

» Bundles und Services können zur Laufzeit in der Plattform 
installiert, gestartet, gestopptund deinstalliertwerden.

» Besteht aus:

» OSGi Framework (Container für Bundles und Services)

» OSGi Standard Services (verschiedene, horizontale Services)

OSG ςwas?
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Die OSGi Alliance:
» http://www.osgi.org
» ZusammenschlußrenomierterUnternehmen
» Gegründet1999
» Derzeitmehrals80 Mitglieder:

» Deutsche Telekom, Eclipse Foundation, IBM, Oracle, Prosyst, 
SAP, Siemens, Sun, SpringSourceetc.

» Spezifiziertund fördert die OSGi Service Platform

Woherkommt die OSGi Service Platform?
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Einige Beispiele:
» Eclipse Platform:

» Eclipse SDKs (IDEs), RCP, eRCPΣ Χ

» IBM
» WebsphereAppServer (basiert auf OSGi)
» Lotus (basiert auf Eclipse-RCP, damit auch OSGi)
» Jazz (basiert auf Server-Side-Eclipse)

» BEA/Oracle
» SpringSourceApplicationPlatform / dm Server
» Adobe
» ...

Wo wird die OSGi Service Platform eingesetzt?
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» Spezifikationen verfügbar unter http://www.osgi.org:
» Die Core Specificationspezifiziert das OSGi Framework

» Das Service Compendiumspezifiziert diverse Standard Services, 
z.B. einen Log Service oder einen PreferencesServices.

» Die Mobile Specificationdefiniert verschiedene Standard 
Services für mobile Applikationen.

Wo ist die OSGi Platform spezifiziert?
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» Modularisierungund Versionierung

» Abhängigkeitsmanagement (zur Laufzeit)

» Hot deployment

» (Fern-) Management des laufenden Frameworks 
über sog. Management Agents

» Serviceorientiertes Programmiermodell

Welche Vorteile bietet die OSGi Service Platform?
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SOA-Konfusion:

» Web Services publizieren und nutzen Dienste über das Netz

» OSGi Services publizieren und nutzen Dienste innerhalb einer 
virtuellen Maschine



» Open Source Implementierungen:
» EclipseEquinox(http://www.eclipse.org/equinox/)

» Apache Felix (http://cwiki.apache.org/FELIX/index.html)

» Knopflerfish(http://www.knopflerfish.org/)

» ProSystmBeddedServer EquinoxEdition 
(http://www.prosyst.com/products/osgi_se_equi_ed.html)

» Kommerzielle Implementierungen:
» ProSyst(http://www.prosyst.com/)

» KnopflerfishPro (http://www.gatespacetelematics.com/)

» Χ

Implementierungen der OSGi Service Platform
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» Basiskomponente der OSGi Service Platform
» Erlaubt die Installation und Verwaltung von Bundles und 

Services
» Verwaltet Abhängigkeiten zwischen Bundles
» Kann über Management AgentsαǾƻƴ ŀǳǖŜƴά ŀŘƳƛƴƛǎǘǊƛŜǊǘ 

werden

Das OSGi Framework
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» Das OSGi Framework ist in mehreren logischen Schichten 
definiert:
» ExecutionEnvironments
» Module Layer
» LifecycleLayer
» Service Layer
» Security Layer (optional)

OSGi Framework: Schichten
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» Execution Environments ...
» ... abstrahierenvon konkretenJREs

» ... definierenKlassen, Interfaces und Signaturen

» OSGi spezifiziertzweiExecution Environments:
» OSGi/Minimum-1.1: MinimaleAusführungsumgebungfür das 

OSGi Framework

» CDC-1.0/Foundation: JME Foundation Profile

» WeitereExecution Environments:
» J2SE-1.5

» JavaSE-1.6

» ...

OSGi Framework: Execution Environments

14



» DerModule Layerdefiniert das Bundle alsgrundlegende
Modularisierungseinheit.

» Das Framework erlaubt die Definition von 
» Sichtbarkeitenvon Modul-Bestandteilen (public-API vs. private-API)

» Abhängigkeiten zwischen Modulen, sowie

» Versionen von Modulen

OSGi Framework: Module Layer
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» DerLifecycle Layer definiertΧ

» ΧŘƛŜ möglichenZuständeeinesBundles sowiederen
Übergänge

» ΧeineAPI, überdie der Lebenszyklusüberwachtund 
manipuliertwerdenkann.

OSGi Framework: Lifecycle Layer
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» DerService Layer ...

» Χdefiniert, wie Services zur Laufzeit über die Service-Registry 
veröffentlichen und wieder entfernen werden können.

» ΧŘŜŦƛƴƛŜǊǘΣ ǿƛŜ Bundles über die Service-Registry Services finden 
und verwenden können.

OSGi Framework: Service Layer
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» DerSecurity Layer ...

» ... ist ein optionalerLayer

» ... basiertauf der Java 2 Security Architektur
» Permissions

» Bundle signing

» Dynamisch

OSGi Framework: Security Layer
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» Management Agentsermöglichen die Administration 
eines OSGi Frameworks.

» Breites Spektrum verfügbar: 

» Kommandobasierte Konsole (Equinox Konsole)

» Grafisch-interaktive Anwendungen (KnopflerfishDesktop, 
ProsystmConsole)

» Web-basierte Oberfläche (KnopflerfishWeb-Konsole)

» Nicht standardisiert, aber Zugriff auf das Framework 
über definierte Schnittstellen.

OSGi Framework: Management AgentsI
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OSGi Framework: Management AgentsII
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Eclipse Equinox Console

ProsystmConsole

KnopflerfishDesktop



OSGi Standard Services
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OSGi-Demo: Sherlog- Log-File-Analyser
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LogEvent Kapselt einen Log-Eintrag

LogEventStore Enthält alle geladenen Log Events

LogEventReader Liest Log Events aus einer Quelle (bspw. Log-Datei  lokal oder 
remote, L4J-SocketAppender)

LogEventFilter Filtert Log Events nach bestimmen Eigenschaften

LogEventView Visualisiert die Log Events aus dem Log Event Store

Sherlog-Domänenmodell
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Sherlog-Systemarchitektur
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Aufgabe:

» Installieren Sie die Eclipse IDE (classic)

» Importieren Sie die Sherlog-Projekte

» Richten Sie den Sample Manager mit den Beispielen ein

Tutorial0: Installation
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» Wir nutzen Eclipse SDK Classic, Version 3.4.2
» z.B. eclipse-SDK-3.4.2-win.zip

» Installation durch Entpacken:
» z.B. c:\ ide\

» Eclipse starten und neuen Workspace anlegen

0.1: Die Eclipse IDE installieren
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» ImportierenSiedie Sherlog-Projekteausder Datei
άƻǊƎΦƧŀǾŀƪƻƴǘƻǊΦǎƘŜǊƭƻƎψмΦлΦлΦȊƛǇέ

0.2: Die Sherlog-Projekteimportieren
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» mŦŦƴŜƴ {ƛŜ ŘƛŜ 5ŀǘŜƛ α target.platform/sherlog.targetά

» Im Target Editor können Sie die Konfiguration als 
Target Platform setzen

0.3 Die PDE Target Platform einrichten
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» Alle Beispiele stehen innerhalb des Sample Managers 
ōŜǊŜƛǘ ό5ŀǘŜƛ αƻǎƎƛψŜȄŀƳǇƭŜǎΦȊƛǇάύ

» Lƴǎǘŀƭƭŀǘƛƻƴ ǸōŜǊ αIŜƭǇ ĔSoftware updatesĔAdd Site... 
Ĕ!ǊŎƘƛǾŜΦΦΦά 

» Aufrufüberά²ƛƴŘƻǿ ĔShow view ĔOther... Ĕ
Other Ĕh{Dƛ ¢ǳǘƻǊƛŀƭǎέ

0.4 Beispiele installieren
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» Χ sinddie Modularisierungseinheiteninnnerhalbdes OSGi 
Frameworks 

» Χ enthaltenzusammengehörigeKlassenund Ressourcen

» ... könnenunabhängigim OSGi Framework deployed werden

» Χ sindJAR-Dateien

» Χ enthaltenein Bundle Manifest, das dasBundle beschreibt

Bundles
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Eclipse Plug-in ProjekteΧ
» ... werdenvomPlug-in Development Environment (PDE) 

bereit gestellt
» ... könnenfür reguläreBundles und für Eclipse Plug-ins 

verwendetwerden
» ... bietenOSGi-Unterstützung

» άbŜǿ tƭǳƎ-ƛƴ tǊƻƧŜŎǘέ ²ƛȊŀǊŘ
» Bundle Manifest Editor
» OSGi run/launch configuration
» Target platform
» Export wizard
» ...

» ... könnendirekt in Eclipse Equinox installiert werden

Eclipse Plug-in Projekte
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» Χ ist Teildes Bundles in der DateiMETA-INF/MANIFEST.MF

» Χ enthält Informationen, die das Bundle beschreiben, z.B.

» den eindeutigenNamenund die Version

» die öffentlicheSchnittstelle/API

» Package-Abhängigkeiten

Das Bundle Manifest
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Manifest - Version: 1.0

Bundle - ManifestVersion : 2

Bundle - Name: Histogram Bundle

Bundle - SymbolicName : org.javakontor.sherlog.ui.histogram

Bundle - Version: 1.0.0

Bundle - Activator : org.javakontor.sherlog.ui.histogram.Activator

Import - Package : org.osgi.framework;version ="1.4.0"

Bundle - ClassPath : .



Manifest Header Bedeutung

Bundle-SymbolicName *
Eindeutiger Name innerhalb des OSGi-Frameworks; 

Konvention: umgekehrter Domain-Name

Bundle-Version
ñmajor.minor.micro.qualifierò, z.B. ñ1.2.3.testò; 

Default: ñ0.0.0ò

Bundle-Classpath
Alle Jars/Verzeichnisse innerhalb des Bundle-Jars, 

die den Klassenpfad bilden. Default ñ.ò

Bundle-Activator
Der BundleActivator wird bei der (De)Aktivierung

des Bundles ausgeführt

Import-Package Eine Liste aller benötigten Pakete

Export-Package
Eine Liste aller Pakete, die API bilden, und für

andere Bundles sichtbar sind

Wichtige Manifest Header
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* erforderlich



» Bestandteil des Plug-in Development Environment (PDE)

» Ermöglicht die interaktive Bearbeitung des Bundle-
Manifestes

» Syntax-Prüfung und Code-Completionfür Manifest-Datei

Der Eclipse Plug-in Manifest Editor
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» JedesBundle kannim Bundle-Manifest einenBundle-
Aktivatordefinieren

» DerBundle-Aktivatormuss das Interface 
BundleActivatorimplementieren

Bundle Aktivierung (1)
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Bundle - Activator : org.javakontor . é .Activator

package org.osgi.framework ;

public interface BundleActivator {

public void start ( BundleContext context ) throws Exception ;

public void stop ( BundleContext context ) throws Exception ;

}



» Das OSGi Framework erzeugtgenaueineInstanzpro 
Bundle

» Wenndas Bundle gestartetwird, wird die start()-
Methodeaufgerufen

» Wenndas Bundle gestopptwird, wird die stop()-
Method aufgerufen

Bundle Aktivierung (2)
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Best practice:

» Da start() und stop() auf dem Framework-Thread ausgeführt 
werden, sollte für langdauernde Aktionen ein eigener Thread 
gestartet werden.



» ... wird mit demaŀƴƛŦŜǎǘ IŜŀŘŜǊ άBundle-Classpathέ 
spezifiziert

» Die Klassenpfad-EinträgewerdendurchKomma
separiert:
» άΦέ steht für das Root-Verzeichnisdes Bundles (der Default-

Klassenpfad)

» weitere EinträgekönnenVerzeichnisseoder JAR-Dateien
innerhalbdes Bundles sein

» AlleEinträgesindBundle-intern und relativ zumRoot-
Verzeichnisdes Bundles

Derinterne Bundle Klassenpfad

38

Bundle - Classpath : ., lib/slf4j - api - 1.4.3.jar



Aufgabe:

» Legen Sie ein neues Bundle
org.javakontor.sherlog.ui.histogram an

» Bei Start des Bundles soll ein JFramemit einem Label 
α[ƻƎ 9ǾŜƴǘ Histogramά ŜǊȊŜǳƎǘ ǿŜǊŘŜƴ

» Beim Stopp des Bundles soll das JFramewieder 
geschlossen werden

Tutorial 1: Ein ĂHistogramñ-Bundle
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» Anlegen eines neuen Plug-in-Projektes in Eclipse:
» File -> New -> Project ... -> Plug-in Project

1.1 Anlegen des Projektes
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public class Activator implements BundleActivator {

private JFrame _frame ;

public void start ( BundleContext context ) throws Exception {

_frame = new JFrame ("Log Event Histogram ");

JLabel label = new JLabel ("Log Event Histogram ", SwingConstants.CENTER );

label.setPreferredSize ( new Dimension(200, 100));

_frame.add( label );

_frame.pack ();

_frame.setVisible ( true );

}

public void stop ( BundleContext context ) throws Exception {

_frame.setVisible ( false );

_frame.dispose ();

_frame = null;

}

}

1.2 Implementierung der Aktivator-Klasse
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Anpassender Launch-Konfiguration:

» Run -Ҕ wǳƴ /ƻƴŦƛƎǳǊŀǘƛƻƴǎΧ

1.3 Starten der OSGi Platform
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1.4 Ausführen den Beispiels
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Agenda
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» Package-Abhängigkeiten müssen explizit angegeben werden:
» Packagesmüssen exportiertwerden, um sichtbar für andere Bundles 

zu sein.
» Packagesmüssen importiert werden, um im Bundlegenutzt werden zu 

können.

» Das OSGi Framework ist verantwortlich für das Auflösen der 
importierten und exportierten Packages.

Package-Abhängigkeiten 
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» Nurdie öffentlicheAPI ist für andereBundles sichtbar

» Die öffentlicheAPI muss im Bundle Manifest explizit
gekennzeichnetwerden

» Manifest-IŜŀŘŜǊ ά9ȄǇƻǊǘ-tŀŎƪŀƎŜέΥ kommaseparierte
AuflistungallerexportiertenPackages

Packages exportieren
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Export - Package : org.jfree.data.statistics , é



» Zunächstkannein Bundle nur Klassenseines 
ά.ǳƴŘƭŜ-Classpathέ sehen

» Um die öffentlicheAPI andererBundles zunutzen, 
müssendieseAbhängigkeitenexplizitangegeben
werden

» ZweiMöglichkeiten, Abhängigkeitenanzugeben:

» Importierenvon Packages (Import-Package)

» Abhängigkeitauf ganzeBundles (Require-Bundle)

Packages importieren
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» DerManifest-IŜŀŘŜǊ άLƳǇƻǊǘ-tŀŎƪŀƎŜέ gibt Package-
Abhängigkeitenan

» ImportiertePackages werdendurchKommagetrennt
aufgelistet

Importieren von Packages mit Import-Package
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Import - Package : org.jfree.data.statistics



» ReferenzierteinbestimmtesBundle überdessensymbolischenNamen
» Bundles werdendurchKommagetrenntaufgeführt

» AlleexportiertenPackages der benötigtenBundles werdenvomBundle 
importiert

» Die Packages allerre-exportiertenBundles der benötigtenBundles werden
ebenfallsautomatischimportiert !

Packages importieren mit Require-Bundle
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Require - Bundle : org.free.chart



» Import-Package ursprünglicher Ansatz, 
Abhängigkeiten auszudrücken

» Require-Bundle hat Nachteile:

» Abhängigkeiten auf ganze Bundles, nicht auf Packages

» Import nicht benötigter Packages

» ά{Ǉƭƛǘ-tŀŎƪŀƎŜǎέΥ ȊǿŜƛ .ǳƴŘƭŜǎ ŜȄǇƻǊǘƛŜǊŜƴ ŘŀǎǎŜƭōŜ 
tŀŎƪŀƎŜΧ

Import-Package oder Require-Bundle
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Empfehlung:
VerwendenSieImport-Package statt Require-Bundle!



» Bundles und Packageslassen sich versionieren

» Versionen:

» major.minor.micro.qualifier, z.B. 1.0.3.20081025NB

» Default: 0.0.0

» Beispiel: Versionierungvon Bundles

» Beispiel: Versionierungvon Packages

Versionen
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Bundle - SymbolicName : org.free.chart

Bundle - Version : 1.0.12

Export - Package : org.jfree.data.statistics ;

version =ñ1.0.12ñ



» Abhängigkeiten können mit Versionsbereichen genauer 
beschrieben werden

» Angabe von Minimalwert und Maximalwert:
» (1.1, 1.2] entspricht: 1.1.0 < x <= 1.2.0

» όύΥ αƎǊǀǖŜǊ-ŀƭǎά ōȊǿΦ άƪƭŜƛƴŜǊ-ŀƭǎά

» ώϐΥ αƎǊǀǖŜǊ-oder-gleich-ŀƭǎά ōȊǿΦ αƪƭŜƛƴŜǊ-oder-gleich-ŀƭǎά

» [1,2] entspricht 1.0.0 <= x <= 2.0.0

» 1.2 entspricht 1.2 < x

» 5ŜŦŀǳƭǘΥ ώлΦлΦлΣ қύ

» Beispiel: Version >= 1.0 und < 1.5 ist:

Versionsbereiche
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Import - Package : org.jfree.data.statistics ;

version =ñ[1.0.0, 1.5.0)ñ



» Passen mehrere Packages/Bundles zu einen 
Versionsbereich, wird das Package/Bundlemit 
höchster Versionsnummer zugewiesen

Importieren versionierter Packages
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» Class Loader: Verantwortlich für das Laden von Klassen in einer VM
» Class Loader-Hierarchie: Zunächst wird Parent nach einer Klasse 

befragt (Delegationsmodell)
» OSGi macht intensiv Gebrauch von Class Loadern...

» Bundles sehen nur Klassen importierter Packages
» Hot-Deploymentvon Bundles

Exkurs: Class Loading in Java
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» Parent Class Loaderist (i.d.R.) der Boot Class Loaderder VM
» Suchreihenfolge:

» Parent Class Loaderfür Klassen aus java.*-Packagesund Packages, die 
ƛƴ αorg.osgi.framework.bootdelegationά ŀǳŦƎŜƭƛǎǘŜǘ ǎƛƴŘ

» Klassen importierter Packageswerden aus CL des jeweiligen Bundles 
geladen

» Class Loaderdes eigenen Bundlewird verwendet

Exkurs: Class Loading in OSGi
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Aufgabe:

» [ŀŘŜƴ {ƛŜ Řŀǎ α¢ǳǘƻǊƛŀƭ-2_Package-5ŜǇŜƴŘŜƴŎƛŜǎά

» Importieren Sie alle zur Ausführung des Beispiel 
benötigten Packages

» Führen Sie das Beispiel aus

Tutorial2: PackageDependencies
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» 5ŀǎ tǊƻƧŜƪǘ αorg.javakontor.sherlog.ui.histogramά 
benutzt Klassen aus verschiedenen Packages

» Die entsprechenden Packagesmüssen noch 
importiert werden

2.1 Die Ausgangssituation
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» Importieren Sie alle benötigten Packages(nutzen Sie dazu 
ōǎǇǿΦ ŘŜƴ ŜƴǘǎǇǊŜŎƘŜƴŘŜƴ αvǳƛŎƪ-CƛȄάύ

» Achtung: In zwei Fällen müssen Packagesimportiert werden, 
die nicht genutzt werden. Welche Packagessind das?

2.2 Importieren der Packages
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» Führen Sie das Beispiel aus Tutorial2 aus

2.3 Ausführen des Beispiels 
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» OSGi-Technologieim Überblick
» Tutorial: Eclipse IDE / Beispieleinstallieren

» Bundles
» Tutorial: EinHistogram-Bundle

» Package-AbhängigkeitenzwischenBundles
» Tutorial: Definition von Package-Abhängigkeiten

» Bundle-Lebenszyklus
» Tutorial: Bundle zurLaufzeitinstallieren

» OSGi Services
» Tutorial: Services anmeldenund abfragen

» Umgangmit dynamischenServices
» Tutorial: Arbeitenmit demServiceTracker

Agenda
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» Bundles habeneinendefiniertenLebenszyklus

» Zustandsänderungenkönnenprogrammatischoder
durcheinenManagement Agent getriggertwerden

» EinigeZustandsübergängeerfolgenautomatisch

DerBundle Lifecycle
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» Das Bundle wird (persistent) im OSGi Framework 
verfügbargemacht

» Dem Bundle wird eineindeutigerBundle identifier (long) 
zugewiesen

» DerBundle-Zustandwird auf INSTALLED gesetzt

Installierenvon Bundles I
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» Ein Bundleim Zustand INSTALLED kann (noch) nicht 
genutzt werden:

» Das Bundlekann nicht gestartet werden

» Packageswerden nicht exportiert

Installierenvon Bundles
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» ImportiertenPackages werdenexportiertePackages 
zugeordnet

» Ist dies erfolgreich, wird der Zustandwird auf RESOLVED 
gesetzt

» Das Resolving erfolgt unmittelbar(nachder Installation) 
oderverzögert

Resolving
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» Ein Bundleim Zustand RESOLVED kann gestartet 
werden

» Exportierte Packageskönnen von anderen Bundes 
importiert werden

Resolving
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» Das Bundle wird in den ZustandSTARTING gesetzt

» DerBundle-Aktivatorwird instantiiert und die start()-
Methodeaufgerufen

» ErfolgreicheRückkehr: das Bundle in den ZustandACTIVE gesetzt

» Fehlerfall: das Bundle in den ZustandRESOLVED gesetzt

Startenvon Bundles
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» Das Bundle wird in den ZustandSTOPPING gesetzt

» Falls einAktivatordeklariertist, wird
BundleActivator.stop() aufgerufen

» Nachder Rückkehrwird das Bundle in den Zustand
RESOLVED gesetzt

Stoppenvon Bundles
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» Updateliestdas Bundle erneuteinund aktualisiertes

» Falls das Bundle Packages exportiert: BestehendePackage-
Zuordnungenbleibenbestehen(stale packages)!

» Refreshführt dazu, dassimportierte Packages neu
zugeordnetwerden

Aktualisierenvon Bundles I

68



» Package-Abhängigkeiten werden nicht automatisch 
neu aufgelöst.

» 9ȄǇƭƛȊƛǘŜǎ αwŜŦǊŜǎƘά ƴƻǘǿŜƴŘƛƎΦ

Aktualisierenvon Bundles II
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» EntferntBundles ausdemOSGi Framework

» Das Bundewird in den ZustandUNINSTALLEDgesetzt

» Falls das Bundle Packages exportiert: Bestehende
Package-Zuordnungenbleibenbestehen(stale packages)!

Deinstallierenvon Bundles I

70



» Package-Abhängigkeiten werden nicht automatisch 
neu aufgelöst.

» 9ȄǇƭƛȊƛǘŜǎ αwŜŦǊŜǎƘά ƴƻǘǿŜƴŘƛƎΦ

Deinstallierenvon Bundles
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» Zustandsänderungenkönnenprogrammatischoder
durcheinenManagement Agents überwachtund 
verändertwerden

Den Bundle-Lebenszyklusmanipulieren
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» KommandobasierterManagement Agent

» IntegralerBestandteilvon Eclipse Equinox

» Wird gestartet, wennEquinox mit -consoleoder
-Dosgi.consolegestartetwird

Die Equinox-Konsole
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Command Effect

ss Zeigtalle installierteBundle mit Id und Zustandan

install <url> Installiertdas angegebeneBundle

update <id> Aktualisiertdas angegebeneBundle

refresh <id> Aktualisiertdas angegebeneBundle

start <id> Startetdas angegebeneBundle

stop <id> Stopptdas angegebeneBundle

bundle <id> ZeigtDetails des angegebeneBundlesan

services[filter] ZeigtregistrierteServices an

help Zeigtdie Hilfe an

Equinox-Konsole: WichtigeKommandos
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Aufgabe:

» 9ƴǘŦŜǊƴŜƴ {ƛŜ Řŀǎ αHistogramά-Bundleaus der 
Launch-Konfiguration und starten Sie das OSGi-
Framework.

» Installieren und starten Sie das Bundleim laufenden 
Framework.

Tutorial3: Lebenszyklus Bundle
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» 9ƴǘŦŜǊƴŜƴ {ƛŜ Řŀǎ αHistogramά-Bundleaus der 
Launch-Konfiguration

3.1 Anpassen der Launch-Konfiguration I
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» Fügen Sie der Launch-Konfiguration die Start-
tŀǊŀƳŜǘŜǊ αςdevōƛƴά ƘƛƴȊǳ

3.2 Anpassen der Launch-Konfiguration II
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» Programmargumente:

» VM-Argumente:

3.3 Argumente spezifizieren
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- os ${ target.os } - ws ${target.ws} - arch 

${ target.arch } 

- nl ${target.nl} - console ïclean - dev bin

- Declipse.ignoreApp =true - Dosgi.noShutdown =true 



Command Effect

ss Zeigtalle installierteBundle mit Id und Zustandan

install <url> Installiertdas angegebeneBundle

update <id> Aktualisiertdas angegebeneBundle

refresh <id> Aktualisiertdas angegebeneBundle

start <id> Startetdas angegebeneBundle

stop <id> Stopptdas angegebeneBundle

bundle <id> ZeigtDetails des angegebeneBundlesan

services[filter] ZeigtregistrierteServices an

help Zeigtdie Hilfean

3.4 Arbeiten mit der Konsole
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» OSGi-Technologieim Überblick
» Tutorial: Eclipse IDE / Beispieleinstallieren

» Bundles
» Tutorial: EinHistogram-Bundle

» Package-AbhängigkeitenzwischenBundles
» Tutorial: Definition von Package-Abhängigkeiten

» Bundle-Lebenszyklus
» Tutorial: Bundle zurLaufzeitinstallieren

» OSGi Services
» Tutorial: Services anmeldenund abfragen

» Umgangmit dynamischenServices
» Tutorial: Arbeitenmit demServiceTracker

Agenda
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Einh{Dƛ {ŜǊǾƛŎŜΧ

» Χist ein einfachesJava-Objekt(POJO), 

» Χwird an der zentralenService Registry registriert,

» Χkannvon der zentralenService Registry abgefragtwerden.

OSGi Services
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OSGi Service Model
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